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1 General information \\Asc

1 General information

In the context of this document ASC represents ASC Technologies AG, its subsidiaries, branch
offices, and distributors. An up-to-date overview of the aforementioned entities can be found at
https://www.asctechnologies.com

ASC assumes no guarantee for the actuality, correctness, integrity or quality of the information
provided in the manuals.

ASC regularly checks the content of the released manuals for consistency with the described
hardware and software. Nevertheless, deviations cannot be excluded. Necessary revisions are
included in subsequent editions.

Some aspects of the ASC technology are described in general terms to protect the ownership
and the confidential information or trade secrets of ASC.

The software programs and the manuals of ASC are protected by copyright law. All rights on the
manuals are reserved including the rights of reproduction and multiplication of any kind, be it
photo mechanical, typographical or on digital data media. This also applies to translations.
Copying the manuals, completely or in parts, is only allowed with written authorization of ASC.

Representative, if not defined otherwise, is the technical status at the time of the delivery of the
software, the devices and the manuals of ASC. Technical changes without specified announce-
ments are reserved. Previous manuals lose their validity.

The general conditions of sales and delivery of ASC in their latest version apply.
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2 Introduction @sc

2 Introduction

The application REPORThneo is a central location for any type of reporting within the product
line neo. Different reports offer a diversified insight into the call landscape in your company. The
reports can be viewed in the application, printed as well as downloaded to be e-mailed to exter-
nal users in an attachment.

The reports provided in the system are either reports or dashboards:

* Reports display the selected data in tables and in graphic form in different levels of detail.
They are the foundation of a permanent and transparent reporting which serves as the
foundation for making well-informed operational and strategic decisions.

» A dashboard widget displays the current evolution of a performance indicator in graphical
form (e. g. bar charts or pie charts). Users can compile their customized dashboards includ-
ing the performance indicators relevant for them from different dashboard widgets which
grants them an overview of the status of decisive success factors or prioritized objective
targets.
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3 Licenses @sc

3 Licenses

No additional licenses are required for using the application REPORTneo.
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4 Start application

During the installation, a shortcut for the neo programs is created on the computer desktop.

1. To start the application directly on the server, double-click on the shortcut REPORTneo.
To access the application from a computer via the web, start the browser and enter the fol-
lowing URL in the address bar:
http://<System-IP>REPORTneo/index.jsf

After you have entered the URL, the following login screen is displayed:

Login Combination Login

Login name*

Password*

Forgot password?

Fig. 1: Login screen

In general, there are the following login options:
+ Single login = normal user login, see chapter "Single login", p. 7

« Combination login, see chapter "Combination login”, p. 8

@ Your system administrator will tell you which login you have to use.
4.1 Single login
Login Combination Login
Login name*

Password*

Forgot password?

Fig. 2: Single login

1. Enter your user name and the password.
2. Click on the button -> Login.

= The welcome screen of the application appears.
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i} Start application &ASC

If you have forgotten your password and requested a new one upon your last login, the follow-
ing window appears:

Your password has expired.

Old password*
New password*

Confirm password*

Fig. 3: Your password has expired

3. Inthe entry field Old password, enter your new password you have received by e-mail.

4. In the entry field New password, enter your new, modified password.
5. Inthe entry field Confirm password, repeat your new, modified password.
6. Click on the button OK.
= The welcome screen of the application appears.
4.2 Combination login

For safety reasons, it may be sensible to assign a combination user to a user. That way it can
be ensured for instance that a supervisor only accesses recorded conversations when a mem-
ber of the work council is present.

If a combination user has been defined, the actual user is only allowed to log in when the com-
bination user has logged in, too. If entering the login data of a combination user is required, pro-
ceed as follows:

1. In the login window, click on the button Combination Login.

Login Combination Login

Login name*

Password*

Forgot password?

Fig. 4: Login

2. The window Combination Login appears.

- neo 6.x Rev. 1 8/27
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Login Combination Login
Login name*

Password*
Combination user*

Combination password*

Forgot password?

Fig. 5: Combination login

3. Enter your user name and your password as well as the user name and password of your
combination user.

4. Click on the button -> Login.
= The welcome screen of the application appears.
To change to the normal login, if required, click on the button Login.

If you have forgotten your password and requested a new one upon your last login, the follow-
ing window appears:

Your password has expired.

Old password*
New password*

Confirm password*

Fig. 6: Your password has expired

5. Inthe entry field Old password, enter your new password you have received by e-mail.

6. Inthe entry field New password, enter your new, modified password.
7. Inthe entry field Confirm password, repeat your new, modified password.
8. Click on the button OK.
= The welcome screen of the application appears.
4.3 Request new password

If you have forgotten your password, you can request a new one via the function Forgot pass-
word? in the different login windows.

1. Click on the text Forgot password?

- neo 6.x Rev. 1 9/27
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Login Combination Login
Login name*

Password*

Forgot password?

Fig. 7: Login window

2. The window Forgot password? appears.

Forgot password?

Login name*

Back

Fig. 8: Request password

3. Enter your user name.
4. Click on the button -> Reset Password.
= You will receive an e-mail containing your new password.

® For this function, your administrator has to have configured a corresponding e-mail server.
Contact your system administrator if you do not receive an e-mail after this step.

5. To return to the login, click on the text Back.

- neo 6.x Rev. 1 10/27



5 User interface REPORTneo \\Asc

5 User interface REPORTneo

The user interface of REPORTneo is divided into a dashboard with an overview of all widgets
and the corresponding widget settings in a detail view as well as into a main view of the se-
lected report and the corresponding detail report settings in a detail view.

5.1 Dashboard

This overview dashboard serves as entry platform of REPORTneo and displays all created re-
ports in widgets.

(asc 1 ce

Agent Recanding Dutbound Cals Agent Recording Tetal Cals Agent Recording Unknown Calis

0 2 0

Agent iccending Intemal Calls Agent ieconding mbound Calls

2 0

® @

Fig. 9: Main view widgets (example)

Here, you can create new report widgets, view the filter settings within an existing widget as well
as edit its settings.

1 Toolbar Contains functionalities for the elements in the main
view, see chapter "Toolbar dashboard", p. 11.
2 Widget You can change the layout of the widgets on the dash-

board by means of a sorting functionality, see chapter
"Tab General", p. 12.

— When hovering the mouse cursor over this icon, the cur-
rent filter and aggregation settings of the report are dis-

(Filter settings) played.
& Opens the detailed view of the widget settings for indi-
vidual configuration purposes, see chapter "Detail report
(Settings) settings", p. 15.
3 ° Adds a new report widget, see chapter "Create report
widget", p. 20.
(Add new widget)
511 Toolbar dashboard

The toolbar of the dashboard offers the following functionalities:
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C @ f1stTenant Admin
Fig. 10: Toolbar dashboard
C Refresh Refreshes the widgets displayed in the overview.
e Logged in as Opens a drop-down menu with different general functionalities,
see chapter "General functionalities", p. 18.

Change Password Menu item which allows changing your password, see chapter
"Change password", p. 18.

Language Menu item which allows selecting the language of the user inter-
face, see chapter "Change language", p. 18. You can only select
languages which have been installed during the installation.

Info Menu item which allows calling up information about the version of
the software, see chapter "Call up info", p. 19.

Logoff Menu item which allows logging off from the application.

5.2 Widget settings
The detail view contains additional information about and functions of the selected widget.
Settings []
4 General Additional Settings = »
Type *
Stacked bar v
Changing the type may resultin resetting your current
Reafios.
Agent Recording Report (agent based)
Refresh interval * v
Sort *
6 :
WidgetSize *
1x1 -
Save Cancel
Fig. 11: Detail view widgets
The detail view consists of the following tabs:
* General
Here, the general settings of the selected report widget are displayed, see chapter "Tab
General", p. 12.
« Additional Settings
Here, you can select additional indicators (KPI) which are supposed to appear in the wid-
get, see chapter "Tab Additional Settings", p. 13.
5.21 Tab General

Here, the settings of the selected report widget are displayed and can be edited.

- neo 6.x Rev. 1
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5 User interface REPORTneo ‘\Asc
< General Additional Settings = »
Type *
Stacked bar v
Changing the type may resultin resetting your current
FaliRos.

Agent Recording Report (agent based)

Refresh interval * -
Sort *

6 3
WidgetSize *

1x1 -

Fig. 12: Tab General

Type Select the representation type of the report widget from the drop-down list.

Depending on the selected report, different representation types are avail-
able, e. g.:

» Stacked bar
* Doughnut
* Funnel

* Number

» Spline

Name Enter a descriptive title for the report widget. If you do not enter a title, the
default name will be used.

Refresh interval ~ Select the interval in which the report widget is supposed to refresh.

Sort Select the position of the widget on the dashboard.
Widget Size Select the size in which the widget is supposed to be displayed on the dash-
board.
5.2.2 Tab Additional Settings

Here, you can select additional indicators (KPI) which are supposed to appear in the widget,
see chapter "Tab Additional Settings", p. 13.

General Additional Settings
KPI selection -
Save Cancel

Fig. 13: Tab Additional Settings

KPI selection Select the required indicators from the drop-down list.
Depending on the widget type, one or several KPIs can be selected.
O = No KPI has been activated.

- neo 6.x Rev. 1 13727



5 User interface REPORTneo ‘\Asc
= KPI has been activated.
To save the selected KPls, click in the detail view.
To discard the selected KPlIs, click on the checked check box once again. To discard all se-
lected KPIs at the same time and cancel the selection process, click on the button Clear.
5.3 Main view report
The main view of the report displays detailed information about the report of the widget selected
in the main view.
< &LASC - ] e 1sl-Tenaal Admin
Agent Recording Total Calls
Cals Recaiding Reasil based on Agenls
mwm:;am iinknesen Caks Toeal Cake
b a O Sear
Fig. 14: Main view of a separate report (example)
By means of the blue bar below the displayed report, the columns can be move to different loca-
tions by drag and drop. Clicking on a column sorts the content.
By clicking on the icon a (Export), you can export the report as an .xcl file. Check the check
box in the first column of the blue bar to export all columns or select the required columns man-
ually.
By means of the search field, you can search for certain terms in the table. If a search has been
successful, only those lines are displayed which contain the search term which is highlighted.
The column overview of the table remains.
5.31 Toolbar report

The toolbar in the main view of the report offers the following functionalities:

& & @ istTenantAdmin

Fig. 15: Toolbar report

O Settings Allows creating new reports as well as configuring the settings of a
report selected in the overview, see chapter "Create report wid-
get", p. 20.
= Print Allows printing the report, see chapter "Print", p. 19.
- neo 6.x Rev. 1 14127
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5.4

5.4.1

e Logged in as Opens a drop-down menu with different general functionalities,
see chapter "General functionalities”, p. 18.

Change Password Menu item which allows changing your password, see chapter
"Change password", p. 18.

Language Menu item which allows selecting the language of the user inter-
face, see chapter "Change language", p. 18. You can only select
languages which have been installed during the installation.

Info Menu item which allows calling up information about the version of
the software, see chapter "Call up info", p. 19.

Logoff Menu item which allows logging off from the application.

Detail report settings
The detail view contains additional information about and functions of the selected report.

Settings []

Report settings Filters >

Type *
Stacked bar -

Changing the type may resultin resetting your current
$RiEiRgS.
Agent Recording Total Calls

Description

Calls Recording Report based on Agents

Cancel

Fig. 16: Detail view report (example)

The detail view consists of the following tabs:

* Report settings
Here, the settings of the selected report are displayed, see chapter "Tab Report settings",
p. 15.

* Filters
Here, possible filter criteria are displayed which can be applied to the data displayed in the
report, see chapter "Tab Filters", p. 16.

Tab Report settings
Here, the settings of the selected report are displayed and can be edited.

- neo 6.x Rev. 1
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5 User interface REPORTneo ‘\Asc
Report settings Filters >
Type *
Stacked bar -
Changing the type may resultin resetting your current
$RiEiRgS.

Agent Recording Total Calls

Description

Calls Recording Report based on Agents

Cancel

Fig. 17: Tab Report settings

Type Select the representation type of the report from the drop-down list.

Depending on the selected report, different representation types are avail-
able, e. g.:

» Stacked bar
* Doughnut
* Funnel

* Number

» Spline

Title Enter a descriptive title for the report. If you do not enter a title, the default
name will be used.

Description Enter a description of the report.

5.4.2 Tab Filters

Depending on the selected report, different filter criteria can be selected which are supposed to
be applied to the data displayed in the report.

4 Report settings Filters

8/18/2020 B ©  9/18/2020 B

Cancel

Fig. 18: Tab Filters (example)

@) In the calendar, select the beginning and the end of the period of time that
the report is supposed to cover or enter the date manually.

c | : Click on the icon @ to enter a specific period of the time.

Click on the icon @ to select a predefined period of time from the drop-down
list below, e. g. Today, Last week, etc.
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5 User interface REPORTneo

ASC

(/'\

To save the settings, click on the button Save.
To discard the settings, click on the button Cancel.
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6 General functionalities

6.1 Change password

1. Click on the menu item @ Logged in as > Change Password in the top right corner of the
user interface.

= The following window appears:

Change password

Current password *

Your current password is required

New password *

Repeat new password *

Save Cancel

Fig. 19: Change password

2. Enter your old password.
3. Enter your new password and confirm it.

4. To save the changed password, click on the button Save.
To cancel the process of changing your password, click on the button Cancel.

Once you have successfully saved the changed password, you have to enter the new password
upon opening the application the next time.

6.2 Change language

1. Click on the menu item @ Logged in as > Language in the top right corner of the user inter-
face.

= The following window appears:

Change language

English (United States) -

Cancel

Fig. 20: Change language
2. Select the language from the drop-down list. Only languages that you have installed during
the installation can be selected.

3. To save the selected language, click on the button Save.
To cancel the process of changing the language, click on the button Cancel.

= The text of the user interface is displayed in the selected language.
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6.3 Call up info
1. Click on the menu item @ Logged in as > Info in the top right corner of the user interface.

= The following window appears:

Version Info

Current Version: 6.5.0-1.0

Close

Fig. 21: Call up info (example)

2. To close the window, click on the button Close.

6.4 Print
This function allows printing the report.

v' Print default in the browser under File > Page Setup: Page orientation has been set to land-
scape

v' Additionally when using the browser Mozilla Firefox:
Print default in the browser under File > Page Setup: Scaling has been set to 110 %.

1. Click on the icon & in the toolbar of the report.
= The print preview appears.

2. To cancel the printing process, click on the button Cancel.
To continue the printing process, click on the button Print.

= The window Print appears.

Drucken *
Drucker
Mame: ‘WASC-IT3 asc.de'\R&D Kopierer Ricoh  ~ | | Eigenschaften...
Status: Bereit
Typ: RICOH MP C2504 PCL &

Standort: 1.0G/Flur (Raum 102)
Kommentar: Kopierer/Drucker A3 + Duplex 5/W-+color & [ Ausgabe in Datei

Druckbereich Exemplare
@ Ales Anzahl Exemplare: E o
Seit 21 bis: |1
* en ven * _’ﬂ _’J _’ﬂ Sortieren
Markierung 1= 2 3
Apbrechen

Fig. 22: Print (example)

3. Set the respective print options.

4. To start printing, click on the button OK.
To cancel the printing process, click on the button Cancel.
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7 Create report widget

1. Click on the icon @ at the bottom right of the dashboard.
= The following window appears:

Add Widget X

Q Recording| (%]

Analysis report

‘ Agen Report (agent based)
0 g Calls [JZeslfs[l3ls] Report based on Agents
i "':"3'==;-,/_-; 8] hep g

Cancel

Fig. 23: Add report widget
2. Select the report that is supposed to be displayed in the widget from the list.
By means of the search, you can search for certain reports.

3. Enter the name of the report in the search field. While entering the first letters, the names of
reports containing this combination of letters is auto-completed and displayed in a list.

4. To select the report and add the widget, click on the button Add.
To cancel the process, click on the button Cancel.

= Upon clicking on the button Add, the widget is displayed on the overview dashboard.

- neo 6.x Rev. 1 20/27
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8 Configure widget
@SC C & stTenant Agmin
Agent Ascording Cutsound Cals Agent Aecaording Total Cals Agent Recording Unknown Calis
= ® = ® ==
Agent Hecording intemal Calls Agent Hecording nbound Calls

Fig. 24: Configure widget (example)

1.  On the dashboard in the widget, click on the icon % .

= The detail widget settings appear:

Settings []
4 General Additional Settings = »
Type *

Stacked bar v

Cha_nging the type may result in resetting your current
FaliRos.
Agent Recording Report (agent based)

Refresh interval * -

Sort *

6 3

WidgetSize *

1x1 -
Save Cancel

Fig. 25: Detail view (example)
2. Adjust the required settings in the tabs of the widget settings, see chapter "Widget set-
tings", p. 12.

3. To save the changes, click on the button Save.
To discard the entries, click on the button Cancel.
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9 Configure report

1. Select a widget on the dashboard.
= The main view of the report appears:

< &LASC - ] e 1sl-Tenaal Admin

Agent Recording Total Calls

Cats Recording Reacil based on Agenls

Irkcund Cals Catbound Cals frbemal Cale inimeen Cale Tetal Cake
Hecorded Lall:
-

Inbsand Calis Outbeund C..0 Internad Calk Inbourd Cu... Cutbednd ... Inig

22000 Yal-Tersanil &, 2 o o 2 2 C 0

220 ki Al Z £ [d 2 2 o a

Fig. 26: Configure report

2. Click on the icon # in the toolbar of the main view of the report.
= The detail report settings appear:

Settings (]
< Report settings Filters >
Type *

Stacked bar -
Changing the type may resultin resetting your current

Fhftirgs.

Agent Recording Total Calls

Description

Calls Recording Report based on Agents

Cancel

Fig. 27: Detail view (example)

3. Adjust the required settings in the tabs of the detail view, see chapter "Detail report set-
tings", p. 15.
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4. To save the changes, click on the button Save.
To discard the changes, click on the button Cancel.
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10 Delete widget

1. To delete a widget, click either on the icon # within a widget on the dashboard or on the
widget itself.

= The detail report settings appear:

Settings []
Report settings Filters >

Type *

Stacked bar -

Changing the type may resultin resetting your current

$RiEiRgS.

Agent Recording Total Calls

Description

Calls Recording Report based on Agents

Cancel

Fig. 28: Detail report settings (example)

2. Click on the icon [ in the header of the detail report settings.
3. Toreally delete the widget, confirm the security prompt.
= The widget is deleted.
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Glossary

KPI
Key performance indicator

URL
Uniform resource locator. Identifies and locates a resource (e. g. a website) about the used
access method (e. g. the used network protocol as HTTP or FTP) and the location of the re-
source in the computer network. (Source: Wikipedia 20th November 2013)

Widget
Component of a graphical dialog system. Consists of a visible window and an invisible object
which saves the configuration of the component. Is used for the interaction with the user and
the automatically updatable display of information.
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